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Safety Instructions

Safety Instructions • English

 WARNING:  This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within 
the product’s enclosure that may present a risk of electric shock.

ATTENTION:	  This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron website, 
www.extron.com.

   
 

  

 
 

 

Sicherheitsanweisungen • Deutsch

WARUNG:	 Dieses Symbol  auf demProdukt soll den Benutzer darauf 
aufmerksam machen, dass im Inneren des Gehäuses dieses Produktes 
gefährliche Spannungen herrschen, die nicht isoliert sind und die einen 
elektrischen Schlag verursachen können.

VORSICHT:  Dieses Symbol  auf dem Produkt soll dem Benutzer in 
der im Lieferumfang enthaltenen Dokumentation besonders wichtige 
Hinweise zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in den 
Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer  
68-290-01) auf der Extron-Website, www.extron.com.

Instrucciones de seguridad • Español

ADVERTENCIA:	 Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de voltaje peligroso sin aislar dentro del 
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN:		 Este símbolo, , cuando se utiliza en el producto, 
avisa al usuario de la presencia de importantes instrucciones de 
uso y mantenimiento estas estan incluidas en la documentación 
proporcionada con el equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad de 
Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.com.

Instructions de sécurité • Français

AVERTISSEMENT :	 Ce pictogramme, , lorsqu’il est utilisé sur le 
produit, signale à l’utilisateur la présence à l’intérieur du boîtier du 
produit d’une tension électrique dangereuse susceptible de provoquer 
un choc électrique.

ATTENTION :	 Ce pictogramme, , lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec 
l’équipement.

Pour en savoir plus sur les règles de sécurité, la conformité à la réglementation, 
la compatibilité EMI/EMF, l’accessibilité, et autres sujets connexes, lisez les 
informations de sécurité et de conformité Extron, réf. 68‑290-01, sur le site 
Extron, www.extron.com.

Istruzioni di sicurezza • Italiano 

AVVERTENZA:	 Il simbolo, , se usato sul prodotto, serve ad avvertire 
l’utente della presenza di tensione non isolata pericolosa all’interno 
del contenitore del prodotto che può costituire un rischio di scosse 
elettriche.

ATTENTZIONE:	 Il simbolo, , se usato sul prodotto, serve ad avvertire 
l’utente della presenza di importanti istruzioni di funzionamento e 
manutenzione nella documentazione fornita con l’apparecchio.

Per informazioni su parametri di sicurezza, conformità alle normative, 
compatibilità EMI/EMF, accessibilità e argomenti simili, fare riferimento alla Guida 
alla conformità normativa e di sicurezza di Extron, cod. articolo 68‑290‑01, sul 
sito web di Extron, www.extron.com.

Instrukcje bezpieczeństwa • Polska 

OSTRZEŻENIE:	 Ten symbol, , gdy używany na produkt, ma na celu 
poinformować użytkownika o obecności izolowanego i niebezpiecznego 
napięcia wewnątrz obudowy produktu, który może stanowić zagrożenie 
porażenia prądem elektrycznym.

UWAGI:	 Ten symbol, , gdy używany na produkt, jest przeznaczony do 
ostrzegania użytkownika ważne operacyjne oraz instrukcje konserwacji 
(obsługi) w literaturze, wyposażone w sprzęt.

Informacji na temat wytycznych w sprawie bezpieczeństwa, regulacji wzajemnej 
zgodności, zgodność EMI/EMF, dostępności i Tematy pokrewne, zobacz Extron 
bezpieczeństwa i regulacyjnego zgodności przewodnik, część numer 68-290-01, 
na stronie internetowej Extron, www.extron.com.

Инструкция по технике безопасности • Русский

ПРЕДУПРЕЖДЕНИЕ:	 Данный символ, , если указан 
на продукте, предупреждает пользователя о наличии 
неизолированного опасного напряжения внутри корпуса 
продукта, которое может привести к поражению 
электрическим током.

ВНИМАНИЕ: 	 Данный символ, , если указан на продукте, 
предупреждает пользователя о наличии важных инструкций по 
эксплуатации и обслуживанию в руководстве, прилагаемом к 
данному оборудованию.

Для получения информации о правилах техники безопасности, 
соблюдении нормативных требований, электромагнитной 
совместимости (ЭМП/ЭДС), возможности доступа и других вопросах 
см. руководство по безопасности и соблюдению нормативных 
требований Extron на сайте Extron: , www.extron.com,  
номер по каталогу - 68-290-01.

http://www.extron.com
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안전 지침 • 한국어 

경고: 	 이 기호  가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의:	 이 기호  가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 항목에 대한 
자세한 내용은 Extron 웹 사이트(www.extron.com)의 Extron 안전 및 규제 준수 
안내서, 68-290-01 조항을 참조하십시오. 

安全说明 • 简体中文 

警告： 产品上的这个标志意在警告用户, 该产品机壳内有暴露的危险
电压，有触电危险。

注意： 产品上的这个标志意在提示用户, 设备随附的用户手册中有重
要的操作和维护(维修)说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍使 
用的特性等相关内容， 
敬请访问 Extron 网站 , www.extron.com，参见 Extron 安全规范指南，产品编号 
68-290-01。

安全記事 • 繁體中文 

警告:  若產品上使用此符號，是為了提醒使用者，產品機殼內存在未隔離的危

險電壓，可能會導致觸電之風險。

注意	  若產品上使用此符號，是為了提醒使用者，設備隨附的用戶手冊中有重

要的操作和維護（維修）説明。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳細資訊，

請瀏覽 Extron 網站：www.extron.com，然後參閱《Extron 安全性與法規遵守手

冊》，準則編號 68-290-01。

Copyright
© 2022 Extron.  All rights reserved. www.extron.com

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.
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FCC Class B Notice

NOTE:	 This device complies with part 15 of the FCC rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and (2) 
This device must accept any interference received, including interference that may 
cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC rules. These limits provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio communications. There is no 
guarantee that interference will not occur. If this equipment does cause interference to radio 
or television reception, which can be determined by turning the equipment off and on, you 
are encouraged to try to correct the interference by one or more of the following measures:

•	 Reorient or relocate the receiving antenna.

•	 Increase the separation between the equipment and receiver.

•	 Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

•	 Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with 
this equipment. Operation with non-approved equipment or unshielded cables is likely to 
result in interference to radio and TV reception. The user is cautioned that changes and 
modifications made to the equipment without the approval of the manufacturer could void 
the user’s authority to operate this equipment.

NOTE:	 For more information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics see the Extron Safety and Regulatory 
Compliance Guide on the Extron website.

http://www.extron.com/68-290-01
http://www.extron.com/68-290-01


Conventions Used in this Guide

Notifications
The following notifications are used in this guide:

DANGER:	

•	 Will result in serious injury or death. 

•	 Entraînera des blessures graves ou la mort.

ATTENTION:	

•	 Risk of property damage. 

•	 Risque de dommages matériels.

NOTE:	 A note draws attention to important information.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.

Extron Glossary of Terms
A glossary of terms is available at http://www.extron.com/technology/glossary.aspx.
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Introduction

This section provides an overview of the Extron Certified DSP Bundle for Microsoft Teams 
Rooms - Medium Room. Topics include:

•	 About this Guide

•	 Overview

•	 Requirements

•	 Application Diagrams

About this Guide
This guide describes the integration of Extron’s Certified DSP Bundle for Microsoft Teams 
Rooms - Medium Room system.

Overview
Microsoft and Extron have come together to provide Microsoft Teams Rooms solutions with 
our certified hardware. Now it’s easier than ever to stay connected with flexibility of realtime 
collaboration from anywhere. The products in our Microsoft Teams Rooms Certified Design 
Solutions have been designed and meticulously tested for best in class performance and 
ease of use. 

Requirements
Extron Equipment List

Product Description Quantity

DMP 64 Plus C V AT 6×4 Digital Matrix Processor w/ AEC, VoIP, & 
Dante

1

XPA U 1002-70V Two-Channel Amplifier, 100 watts at 70 volts 1

SF 3CT LP 3” Full-Range Ceiling Speakers, 70/100V, Pair 1

SPK16P 16 AWG Plenum Speaker Cable - 75’ (22.8 m) 1

USB CFG Cable USB A Male to USB Mini B Male 6’ (1.8 m) 1

Audio Cable Balanced audio cable for Audio DSP output to 
Amplifier Input - 6’ (1.8 m)

1

Network Cable Cat-6 Plenum network cable - 35’ (10.7 m) 2

Network Cable Cat-6 Non-Plenum network cable - 6’ (1.8 m) 1

Sennheiser Equipment List

Product Description Quantity

TeamConnect Ceiling 2 Beamforming Ceiling Microphone array 1

SL CM EB US Ceiling Mic Extension Brackets, US 1
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Additional Required Equipment

Product Description Quantity

MTR Computer Microsoft Teams Rooms Computer with  
Camera and Control interface

1

Network Switch 10-port PoE network switch 1

Windows computer or 
laptop

Computer must contain the following:
•	 Extron DSP Configurator 

•	 Dante Controller 

•	 Sennheiser TCC2 Control Cockpit 

•	 Extron DSP Configuration *.zip files

1

NOTE:	 The Windows computer or laptop is required for adjustments and can be 
disconnected after system configuration.

Application Diagrams
The following illustrations are examples of configuring the DMP 64 Plus for use with Teams 
in a conference room.

SF 3CT LP

HDMI to
Display

DMP 64 Plus C V AT

XPA U 1002-70V

MTR Computer (OFE)

SF 3CT LP

Display (OFE)

Sennheiser
TeamConnect Ceiling 2
Ceiling Mic

PTZ Camera (OFE)

LAN

Video Audio Control Dante USB

Figure 1.	 Conference Room Application Example1  



 

Extron Certified DSP Bundle for Microsoft Teams Rooms - Medium Room Setup Guide • Introduction 3

Figure 2.	 System Diagram Example

NOTE:	 The supplied network switch is manageable, however the default 
configuration is sufficient for this solution to function.

Installation Details
See figure 3 for the connections needed between the DMP Plus and the XPA U amplifier. 
Use the supplied balanced audio cable to connect each product.

Do not tin 
the wires!Balanced Dual Mono Input

Tip
Ring

Sleeve (s)
Tip

Ring

L
R

XPA U 5-pole Audio INPUT Wiring
DMP Plus 3-pole Audio OUTPUT Wiring

Balanced Output

Tip

Sleeve
Ring

Figure 3.	 Captive Screw Audio Cable Wiring

Speaker Installation
During installation of the speaker(s), please 
ensure the rotary tap selector switch is set to 
70V, 16W.

8W16W

100 V

70 V

4W 2W

4W2W1W 8W
8Ω8Ω

16W

Adjust the Tap Selector

8W
16W

100 V 70
 V4W

2W

4W
2W
1W

8W
8Ω

8Ω

16W

For detailed setup instructions please refer to 
the SF 3CT LP setup guide.

2  

3  

Do not tin 
the wires!Balanced Dual Mono Input

Tip
Ring

Sleeve (s)
Tip

Ring

L
R

XPA U 5-pole Audio INPUT Wiring
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Configuring Extron 
Certified DSP Bundle 
for Microsoft Teams 
Rooms - Medium 
Room

This section provides information on the following topics:

•	 Configuration Overview

•	 Sennheiser TeamConnect Ceiling 2 Setup

•	 Dante Controller Setup

•	 Extron DMP 64 Plus Setup

•	 Microsoft Teams Rooms Setup

Configuration Overview
1.	 Unbox and connect the provided hardware using the above diagram (see figure 2 on 

page 3).

NOTE:	 Do not connect the USB cable between the Microsoft Teams Rooms (MTR) 
computer and Extron DMP Plus. This will be connected after the Extron DMP Plus is 
properly configured.

2.	 Configure a computer with the following software utilities:

•	 Extron DSP Configurator Software

•	 Dante Controller Software

•	 Sennheiser Control Cockpit Software

3.	 Download the following from the Extron website (www.extron.com/microsoft):

•	 Extron Certified DSP Medium Room Bundle .zip folder

Sennheiser TeamConnect Ceiling 2 Setup

Sennheiser TeamConnect Ceiling 2
Sennheiser TeamConnect 2 (TCC2) audio output is connected to the Extron DMP Plus 
series via the Dante audio connection.

An additional PoE/Control connection is required to support LED feedback, microphone 
mute controls as well as powering the ceiling microphone. Figure 4 on page 5 shows 
the browser-based Control Cockpit interface used to detect and identify the TCC2.

http://www.extron.com/microsoft
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The browser-based Control Cockpit interface detects and identifies the TCC2 using mDNS 
when the network cable is attached to the TCC2 Ethernet PoE/Ctrl port.

Figure 4.	 Control Cockpit Interface

From this interface, the following actions are performed:

•	 Setting Network Settings

•	 Beam-steering and Exclusion Zone adjustments

Setting Network Settings

Set and document IP/host name of the device. This will be required later.

Figure 5.	 Control Cockpit Network Interface

Beam-steering and Exclusion Zone Adjustments (Optional)

If additional settings are required to reduce background of items such as HVAC, projector 
fans, credenzas, etc. the TCC2 has a Priority Zone and up to 5 Exclusions Zones which can 
be leveraged to remove these from the microphone pickup. 

To configure a zone: 

1.	 Select the desired unit from the Device List, a Properties dialog box is opened.

2.	 Under the Zones tab, the 3D Overall View shows the real-time focus of the TCC2 
automatic beam-steering (see figure 6 on page 6). Users can manually enable a 
Priority or Exclusion Zone, 

3.	 Edit the vertical and horizontal angles of the selected exclusion zones (see figure 7 on 
page 6) to remove the observed noise.

NOTE:	 Refer to the TeamConnect Ceiling 2 instruction manual for more 
information.

4  

5  
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Figure 6.	 Control Cockpit  

Properties Window
Figure 7.	 Control Cockpit  

Zones Tab

Dante Controller Setup
Dante Controller from Audinate is required to route transmitters and receivers, and can be 
used to configure Dante settings and monitor performance. 

Creating Subscriptions Between Sennheiser TCC2 and Extron DMP 64 Plus 
1.	 Ensure the Laptop, DMP 64 Plus C V AT (Dante), and TCC2 (Dante) are connected to 

the same network. 

2.	 From the Windows Start Menu select: All Programs > Audinate > Dante 
Controller. The Dante Controller - Network View screen opens. Dante 
Controller auto-discovers Dante devices on the network and advertises itself to allow 
other Dante-enabled devices to communicate with it. Transmitters connect to receivers 
using the subscription matrix (see figure 8). 

Figure 8.	 Routing Tab of Network View Screen 

NOTE:	 The DMP 64 Plus and TCC2 Dante connections are set to DHCP by default. 
If they cannot be discovered, ensure the correct interface is selected on the PC 
by selecting Interfaces from the File menu.

6  

7  

8  
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3.	 Open the Device View of the DMP 64 Plus by double clicking it in the Routing tab.

4.	 In the Receive tab, rename the first receive channel to TCC2-A.

  

Figure 9.	 Receive Tab of Network View Screen

5.	 In the Transmit tab, rename the first transmit channel to TCC2 Ref.

 

Figure 10.	 Transmit Tab of Network View Screen 

6.	 In the Device Config tab, rename the DMP 64 Plus to the desired name and click 
Apply.

 

Figure 11.	 Device Config Tab of Network View Screen 

7.	 From the Device View pulldown, choose the TCC2.

8.	 In the Device Config tab, rename the TCC2 to TCC2-A.

9  

10  

11  
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Figure 12.	 Renaming the Device 

9.	 Close the Device View window and return to the Network View window.

10.	To show the transmitters of a Dante device, click the + box next to the desired device in 
the Dante Transmitters panel, such as TCC2-A (see figure 13 on page 9). The 
+ changes to a - sign when the device expands. 

11.	To show the receivers of a Dante device, click the + box next to the desired device in 
the Dante Receivers panel, such as DMP64PlusCAT.

12.	Click the intersections of the desired subscriptions between transmitter and receiver 
channels.

12  



 

Extron Certified DSP Bundle for Microsoft Teams Rooms - Medium Room Setup Guide • Configuration 9

Figure 13.	 Network View Screen 

NOTES:	

•	 The FarEndOut transmitter channel of the TCC2 should be routed to the first 
receiver channel of the DMP 64 Plus. A check mark at the intersection indicates 
the subscription is made. A check mark also appears next to the receive channel.

•	 The TCC2 Ref transmitter channel of the DMP 64 Plus should be routed to the 
AEC Ref receiver channel of the TCC2.

13  
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Extron DMP 64 Plus Setup
To configure the Extron DMP 64 Plus, perform these steps:

1.	 Set IP address via embedded web page

2.	 Set the computer’s or laptop’s IP address within the range of the product’s IP address. 
The default address (LAN for non-V-models, LAN 1 for V-models) is: 

•	 192.168.254.254

•	 Subnet 255.255.255.0

•	 Gateway 0.0.0.0

3.	 From a web browser, enter the device IP address into the address field. 

NOTE:	 If the local system administrators have not changed the IP address, and the 
device has not been assigned an IP address via DHCP, the default address (LAN 
for non-V-models, LAN 1 for V-models) is 192.168.254.254.

4.	 Press Enter.

5.	 On the login page, enter “admin” as the Username, enter the Password (if one has been 
set), and click Sign In. 

•	 By default, the password is the product’s serial number

•	 If mode 5 reset has been performed, then the password will be clear and the 
Password field can be left blank.

Figure 14.	 Login Page

The Communications Settings Panel displays TCP/IP communication settings. Click 
Edit to open the Communication Settings dialog box and edit the TCP/IP settings. 

The following can be edited: DHCP status, IP address, subnet mask, and default 
gateway. This dialog box also displays the device MAC address. To revert the 
computers IP address to a range which can communicate to the new IP address 
schema.

NOTE:	 If Use DHCP is enabled, IP address, subnet mask, and default gateway 
cannot be edited.

14  
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Figure 15.	 Communications Settings Panel 

To push the DSP Template file to the DMP Plus:

1.	 Open the Extron DSP Template file (downloaded previously in .zip file) with DSP 
Configurator software.

2.	 Connect to a DMP 64 Plus in Live Mode by clicking the Live button in the menu bar 
of DSP Configurator (see figure 16, 1). Alternatively, select Tools > Connect to 
Device or press F6 on the keyboard. The Connect to Device dialog box opens. 

Figure 16.	 Live Button 

3.	 Click the TCP/IP tab in the dialog box. 

4.	 Enter the IP address of the device in the Hostname or IP Address field. If necessary, 
enter the device password in the Password field.

5.	 When a connection type with a device is established, the Synchronize with Device 
dialog box opens. Select Push.

15  

16  
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Figure 17.	 Synchronize with Device Dialog Screen 

6.	 Click OK.

Once the push is completed, the current state of the connected DMP 64 Plus is displayed 
in the DSP Configurator status panel and the device is ready for further configuration.

USB Naming
The USB Audio tab allows for customizing USB audio interface names and terminal types. 
To configure USB Audio settings in DSP Configurator: 

NOTE:	 Extron recommends configuring these settings before connecting USB audio 
devices to a PC. 

1.	 From the Tools menu, select Device 
Settings. The Device Settings dialog 
box opens. 

2.	 Click the USB Audio tab. 

3.	 In the USB Name field, enter the 
desired name for the USB Audio 
interface. 

4.	 In the USB Terminal Type 
panel, choose Echo Cancelling 
Speakerphone. 

5.	 Click Apply to activate the new 
settings. 

6.	 Connect the USB audio port to the 
PC.

17  
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Edit Macros
Macros are sets of actions that can affect the local DMP 64 Plus and other Extron products 
on the same TCP/IP network. Macros are required for the Mute Sync Status indicators 
on the Sennheiser microphone to function properly. They can be configured in Emulate or 
Live mode via an Ethernet connection only, and they can be saved to a configuration file or 
pushed to DMP 64 Plus internal memory. Macros are comprised of up to 32 actions that 
occur in sequence to quickly configure a system for specific applications.

Figure 18.	 Configure Macros Screen

1.	 Select 7 Edit Remote Destinations.

2.	 Select TCC2-A and update the IP address to match the microphone that was 
configured earlier

3.	 Select Apply.

4.	 Select 8 Push Macros to Device.

Figure 19.	  Add/Edit Macro Destinations Dialog Box

18  
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Microsoft Teams Rooms Setup
The Extron DMP 64 Plus connects to the Microsoft Teams Rooms system from the USB 
Audio port.

Once the previous steps outlined in this document have been complete, please connect the 
Microsoft Teams Rooms Rooms system to the DMP 64 Plus USB Audio connection via the 
provided USB mini-B cable.

The following steps detail the required settings on the Microsoft Teams Rooms 
Room device:

1.	 Select “More” in the Teams Rooms interface

Figure 20.	 Microsoft Teams Rooms Room Interface Screen 

2.	 Select “Settings”

Figure 21.	  Microsoft Teams Rooms Settings

20  
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3.	 In the Settings menu, select Peripherals, and use the dropdown menus to select 
the Extron DMP Plus (or configured USB Name in above steps) for each of the three 
parameters: Microphone for Conferencing, Speaker for Conferencing, and Default 
Speaker. 

 

Figure 22.	 Microsoft Teams Rooms Peripherals Dialog Box 

4.	 When you are finished, click Save and exit to return to the user interface.

NOTE:	 When using the Extron DMP 64 Plus, MTR disables its internal acoustic echo 
cancellation (AEC) audio processing so that all audio processing is completed 
through the external DSP—the Extron DMP 64 Plus. This provides the best audio 
performance.

22  
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Advanced Settings 
and Troubleshooting

This section provides the following topics:

•	 DMP Plus Acoustic Echo Cancellation (AEC)

•	 Technical Support

DMP Plus Acoustic Echo Cancellation (AEC)

AEC Setup Overview
Proper gain structure involves the relationship between the signal at the selected reference 
and the signal at the mic input, within the context of proper levels for the reference and mic 
inputs independently. The mic input gain setting will naturally be optimized for the voice level 
of the talker in that room; therefore, the amount of signal from the far end that is picked up 
by the mic is dependent on how much that far end signal is being amplified in the near end 
room and the distance from the mic to the speakers.

The reference signal is the signal received from the far end, which arrives at the USB-
assigned Aux Inputs of the DMP Plus. This is sent to the sound reinforcement system within 
the near end room, as well as a designated output channel to set the reference level for the 
DMP Plus AEC processor. 

AEC Dialog
The AEC dialog contains meters and indicator LEDs that are essential for setting up gain 
structure and monitoring activity. 
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Figure 23.	 AEC Controls

AEC Indicators

•	 Far – lights when activity is detected from the remote site. 

•	 Near – lights when activity is detected from the local site. 

•	 Update – lights when the AEC is updating, i.e., converging or reconverging. 

Meters

•	 ERL – the ratio in dB between the signal at the reference and the signal at the AEC 
channel input. When ERL is a positive number, the signal level at the AEC channel input 
is lower than the signal at the selected reference. 

NOTE:	 The ideal level range for these meter is 0 to +15 dB. This ensures the right 
amount of reference signal is being sent through the AEC processor..

•	 ERLE – the amount in dB of potential echo signal that the AEC algorithm, not including 
NLP processing, is cancelling. 

•	 TER – the sum of ERL + ERLE, in dB. 

Select Reference

The provided configuration includes a selected AEC reference. If necessary, a different AEC 
reference can be selected from the drop-down list.

23  
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Noise Cancellation
Noise Cancellation may be switched on or off from the AEC dialog. The noise canceller will 
detect steady state noise, such as HVAC or other continuous system noise, and effectively 
remove it without causing audible artifacts.

Advanced AEC Controls
Click on the open/collapse icon to expose the advanced AEC controls.

Advanced control functionality is as follows:

Non-linear processing (NLP) controls

•	 Enable NLP – this box is checked by default. Non-linear processing is necessary for 
the complete removal of echo.

•	 NLP Presets – click a button to load a set of values to the three NLP parameters. 

•	 Max NLP Reduction – the maximum possible reduction in echo artifacts that can be 
applied.

•	 Attack Time – the speed in which NLP is applied.

•	 Release Time – the speed in which NLP is released.

Additional controls

•	 Double Talk Echo Reduction – sets the amount of echo reduction applied during 
double-talk. 

•	 Comfort Noise – sets a comfort noise level in dB to eliminate states of complete 
silence, which may be perceived as a failed connection. 

Technical Support
For Extron technical support, visit: https://www.extron.com/company/contactus.aspx 

For Sennheiser technical support, visit: https://sennheiser.com/service-support

https://www.extron.com/company/contactus.aspx
https://sennheiser.com/service-support


Contact Information

Worldwide Headquarters:  Extron USA West, 1025 E. Ball Road, Anaheim, CA 92805, 800.633.9876

Extron Warranty

Extron warrants this product against defects in materials and workmanship for a period of three years from the date 
of purchase. In the event of malfunction during the warranty period attributable directly to faulty workmanship and/
or materials, Extron will, at its option, repair or replace said products or components, to whatever extent it shall 
deem necessary to restore said product to proper operating condition, provided that it is returned within the warranty 
period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America:
Extron 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

Asia:
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Japan:
Extron Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe:
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China:
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Middle East:
Extron Middle East 
Dubai Airport Free Zone 
F13, PO Box 293666 
United Arab Emirates, Dubai

Africa:
Extron South Africa 
3rd Floor, South Tower  
160 Jan Smuts Avenue  
Rosebank 2196, South Africa

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process.

	 USA:	 714.491.1500 or 800.633.9876	 Asia:	 65.6383.4400 

	 Europe:	 31.33.453.4040 or 800.3987.6673	 Japan:	 81.3.3511.7655
	 Africa:	 27.11.447.6162	 Middle East:	 971.4.299.1800 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron be liable for direct, indirect, or 
consequential damages resulting from any defect in this product even if Extron has been advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.
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